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1. Jendela	Kerja	Microsoft	PowerPoint	
Pada	pertemuan	pertama	kali	 ini	anda	akan	mengenal	 jendel	kerja	Microsoft	PowerPoint	2013.	Apabila	
anda	menggunakan	versi	terbaru	maka	ada	perubahan	pada	desain	interface	dan	beberapa	penempatan	
menu	dan	icon,	tetapi	secara	fungsi	utama	dari	menu	dan	icon	tetap	sama.	
	

1.1 Masuk	ke	Jendela	Kerja	Microsoft	PowerPoint	2013	
Untuk	memasuki	Microsoft	PowerPoint	2013	menggunakan	Windows	10,	cara	terstrukturnya	sebagai	
berikut	:	
1. Klik	Logo	Windows	(	Windows	10	)	
2. Ketik	PowerPoint	2013	
3. Kemudian	pilih	Microsoft	PowerPoint	2013	

	

	

	

	

	

	

	

	

4. Pilih	Blank	Presentation	
	

	

PERTEMUAN KE 1       JENDELA KERJA MICROSOFT  POWERPOINT 20 13  
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1.2 Mengenal	Fungsi	Menu	&	Tools	Utama	
Menu	dalam	Microsoft	PowerPoint	Terdiri	dari	File,	Home,	 Insert,	Design,	Transitions,	Animations,	Slide	
Show,	Review,	View,	Format.	
	

	
	
Icon	 bar	 merupakan	 symbol/command	 yang	 terdapat	 dalam	 masing-masing	 menu	 utama	 Microsoft	
PowerPoint,	 contoh	 dalam	 menu	 insert	 icon-icon	 seperti	 New	 Slide,	 Table,	 Picture,	 Shapes,	 SmartArt,	
WordArt,	Video,	Audio	dan	seterusnya.	
	

	
	
Icon-icon	 tersebut	 dikumpulkan	 dalam	 kelompok	 tertentu	 yang	 disebut	 Ribbon,	 Misalnya	 kelompok	
Slides,	Tables,	Images,Links,	Media	dan	seterusnya.	
A. Design	
1. Page	SetUp	:	berfungsi	untuk	mengatur	ukuran	slide.	
2. Slide	Orientation	:	berfungsi	untuk	orientasi	slide.	
3. Themes	:	berfungsi	untuk	mengubah	slide	agar	lebih	menarik.	
4. Colors	:	berfungsi	untuk	merubah	warna	tema	slide	sesuai	keinginan.	
5. Fonts	:	berfungsi	untuk	merubah	bentuk	huruf	pada	slide.	
6. Effects	:	berfungsi	untuk	memberikan	efek	pada	tema.	
7. Background	Style	:	berfungsi	untuk	mengatur	background	/	latar	belakang	pada	slide.	

	

	

B. Menu	Transitions	
Tap	Transitions	terdiri	dari	3	group	yaitu:		
1. Group	Preview	
2. Group	Transition	to	This	Slide	
3. Timing	
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C. Animations	
Pada	Ribbon	Tab	Animation	ini	terdapat	beberapa	sub	menu,	diantaranya	:	
1. Preview	:	berfungsi	untuk	menampilkan	hasil	animasi	yang	telah	dibuat	pada	slide.	
2. Animation	:	berfungsi	untuk	membuat	animasi	pada	setiap	slide.	
3. Advanced	Animation	:	berfungsi	untuk	membuat	efek	suara	pada	pergantian	slide.	
4. Timing	:	berfungsi	untuk	mengatur	kecepatan	pada	pergantian	slide.	

	

D. Slide	Show	
1. From	Beginning			 :	Berfungsi	untuk	menjalankan	slide	mulai	dari	awal	hingga	akhir	slide.	
2. From	Current	Slide		:	Berfungsi	untuk	menjalankan	slide	mulai	dari	slide	yang	dipilih	hingga	akhir	slide.	
3. Custom	Slide	Show		:	Berfungsi	untuk	mengatur	penampilan	slide	sesuai	keinginan.	
4. Set	Up	Slide	Show		 :	Berfungsi	untuk	mengatur	tampilan	slide.	
5. Hide	Slide														 :	Berfungsi	untuk	menyembunyikan	slide.	
6. Record	Narration		 :	Berfungsi	untuk	menampilakan	suara	narasi.	
7. Rehearse	Timing					 :	 Berfungsi	 untuk	 mengatur	 lamanya	 tampilan	 slide	 dengan	 waktu	 yang	 telah	

ditentukan.	
8. Resolution						 :	Berfungsi	untuk	memilih	resolusi	yang	akan	digunakan	pada	slide.	
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E. Review	
1. Spelling&Grammar	:	berfungsi	untuk	menambahkan	dan	pengejaan	tata	bahasa.	
2. Research	:	berfungsi	untuk	pencarian	bahan-bahan	untuk	refernsi.	
3. Translate	:	berfungsi	untuk	menerjemahkan	teks	yang	ada	pada	slide.	
4. New	Comment	:	berfungsi	untuk	memberikan	catatan	/	komentar	pada	slide	yang	telah	dibuat.	
5. Protect	Presentation	:	berfungsi	untuk	melindungi	slide	yang	telah	dibuat.	

	

	

F. View	
Pada	 Ribbon	 Tab	 View	 terdapat	 beberapa	 sub	 menu	 yang	 masing-	 maisng	 memiliki	 fungsi,	
diantaranya	:	
1. Normal			 :	Berfungsi	untuk	menampilkan	secara	lengkap	seluruh	isi	slide	peresentasi.	
2. Slide	Sorter		 :	Berfungsi	untuk	menampilkan	keseluruhan	slide	yang	telah	dibuat	dalam	bentuk	

miniatur.	
3. Notes	Page		 :	Berfungsi	untuk	menampilkan	slide	secara	lengkap	dengan	disertai	catatan	yang	

telah	ditambahkan.	
4. Slide	Show		 :	Berfungsi	untuk	memulai	menampilkan	slide	presentasi.	
5. Slide	Master		 :	 Berfungsi	 untuk	 menempatkan	 dan	 menambahkan	 teks	 maupun	 objek	 yang	

akan	ditempatkan	pada	setiap	slide	yang	akan	dibuat.	
6. HandoutMaster	:	Berfungsi	untuk	menampilkan	seluruh	slide	apabila	akan	dicetak.	
7. Notes	Master		 :	Berfungsi	untuk	membuka	catatan	pada	slide.	
8. Zoom		 	 :	Berfungsi	untuk	mengatur	ukuran	jendela	kerja.	
9. Fit	to	Window		 :	 Berfungsi	 untuk	menentukan	 tampilan	 slide	 presentasi	 dengan	 tampilan	 yang	

sesuai	dengan	jendela	Power	Point.	
	

	

G. Format	
Menu	Format	berfungsi	untuk	menentukan	jenis	huruf,	paragraf,	memberikan	penomoran,	membuat	
jenis	kolom	dalam	teks,	memberi	bingkai	dan	arsiran,	mengatur	huruf	besar	dan	kecil	dan	berbagai	
hal	 yang	 berkaitan	 dengan	 format	 dokumen.	 Untuk	 lebih	 jelasnya	 mengenai	 fungsi	 menu	 format,	
berikut	berbagai	fungsi	dari	tool-tool	yang	terdapat	dalam	menu	format.	
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1.3 Praktik	Pertemuan	ke	1	
Buatlah	presentasi	slide	berikut	:	
	

	
	

	
	
KETENTUAN	:	

Slide	1	:	Sampul	
Slide	2	:	Isilah	Nama,	Alamat,	Email	pada	slide	
Slide	3	:	

•	Buatlah	box,	oval,	lingkaran	dan	anak	panah	menggunakan	AutoShapes	
Slide	4	:	Penutup	

•	Buatlah	slide	design	:	balance	
•	Buatlah	Slide	Transition		
•	Buatlah	animati	tulisan	/	box	atau	table		
•	Buatlah	Footer	meliputi,	hari	tanggal	bulan	dan	tahun	secara	update	automatically	

	
	
	
	

	

	

	

	



Modul Pelatihan Komputer Microsoft PowerPoint 2013 Ver.1.0 9	

	

2. Membuat	Design	Slide	PowerPoint	
Presentasi	yang	baik	didukung	oleh	slide	yang	dirancang	dengan	baik.	Sebagian	besar	desain	Anda	agak	
tidak	 terlihat,	 hanya	 saja	 ada	 sesuatu	 yang	 salah	 dengan	 desain	 slide	(bayangkan	 warna	 menakutkan	
misalnya)	sehingga	Anda	akan	melihat	bagaimana	desain	bisa	menjadi	masalah	dalam	sebuah	presentasi.	
	

2.1 Pengaturan	/	Tata	Letak	
1. Pada	tab	design,	di	group	customize	di	ujung	kanan,	klik	slide	size.	
2. Klik	Custom	Slide	size.	

	

	

3. Di	slide	size,	klik	ukuran	yang	ingin	anda	gunakan,	atau	gunakan	kotak	Width	dan	Height	untuk	
memilih	ukuran	custom.	

4. Klik	OK	
	

2.2 Memilih	Bentuk	Design	
Anda	 dapat	 menampilkan	 slide	 PowerPoint	 dalam	 berbagai	 cara,	 tergantung	 pada	 tugas	 yang	 sedang	
dikerjakan.	 Beberapa	 tampilan	 dapat	 bermanfaat	 ketika	 membuat	 presentasi,	 dan	 beberapa	 tampilan	
lainnya	 akan	 bermanfaat	 ketika	 menyampaikannya.	 Anda	 dapat	 menemukan	 beberapa	 opsi	 tampilan	
PowerPoint	di	tab	View,	seperti	yang	diperlihatkan	di	bawah	ini.	
	

	

Anda	juga	bisa	menemukan	tampilan	yang	paling	sering	digunakan	pada	bilah	tugas	di	bagian	kanan	
bawah	jendela	slide.	

	

	
	

PERTEMUAN KE 2   DES IGN SLIDE MICROSOFT POWERPOINT  2013  



Modul Pelatihan Komputer Microsoft PowerPoint 2013 Ver.1.0 10	

2.3 Menggunakan	WordArt	
2 Klik	tab	menu	insert	>	Pilih	ikon	WordArt	
3 Selanjutnya	akan	ditampilkan	kotak	dialog	WordArt	Gallery	yang	menampilkan	berbagai	model	

WordArt	

	

4 Klik	salah	satu	model	WordArt	dalam	kotak	dialog	WordArt	Gallery	
5 Secara	otomatis,	huruf	yang	anda	ketik	akan	mengikuti	model	WordArt	yang	telah	dipilih	

	
2.4 Menyisipkan	Image	/	CliptArt	

1. Klik	tab	menu	insert	>	Pilih	ikon	Pictures	

	

2. Pilih	gambar	yang	akan	anda	sisipkan	
3. Klik	Insert	

	

	

2.5 Membuat	Table	
1. Klik	tab	menu	insert	>	Pilih	ikon	Table	
2. Pilih	table	sesuai	dengan	kebutuhan	anda	
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2.6 Praktik	Pertemuan	ke	2	
Buatlah	presentasi	slide	berikut	:	
	

	
	

	
	
	
KETENTUAN	:	
	

• Ubah	slide	dalam	bentuk	widescreen	16:9	
• Masukkan	gambar,	WordArt	dan	Tabel	
• Selamat	berkreasi	☺	
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3. Custom	Animation	
Ada	 Transition,	 ada	 Custom	 Animation.	 Transtition	 adalah	 efek	 yang	 berdampak	 pada	 slide	 per	 slide	
sedangkan	 Custom	 Animation	 adalah	 efek	 kata	 per	 kata	 atau	 gambar	 per	 gambar.	 Jadi	 bisa	Custom	
Animation	ditambahkan	 untuk	 	mempercantik	 tampilan	 presentasi	 anda.	 Pada	 posting	 ini	 saya	 khusus	
menerangkan	tentang	Custom	Animation.	
	

	
	

3.1 Memilih	Animasi	Entrance	
Entrance	adalah	efek	Masuk	suatu	kata	atau	gambar		
pada	slide.	Didalam	Entrance	ada	efek	Blinds,	Box,		
Checkerboard,	Diamond	dan	Fly	in	atau	efek	lain		
ditandai	dengan	tulisan	more	effects.	
	

	

	

	

	

	

	

	

	

	

PERTEMUAN KE 3      CUSTOM AN IMATION M ICROSOFT POWERPOINT 2013  
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3.2 Memilih	Animasi	Emphasis	
Emphasis	adalah	efek	Ditempat	suatu	kata	atau		
gambar	pada	slide.	Didalam	Emphasis	ada	efek	
Change	Font,	Change	Font	Size,	Change	Font	Style,	
Grow/Shrink	dan	Spin	atau	efek	lain	ditandai		
dengan	tulisan	more	effects.	
	

	

	

	

3.3 Memilih	Animasi	Exit	
Exit	adalah	efek	Keluar	suatu	kata	atau	gambar		
pada	slide.	Didalam	Exit	ada	efek	efek	Blinds,		
Box,	Checkerboard,	Diamond	dan	Fly	in	atau		
efek	lain	ditandai	dengan	tulisan	more	effects.	
	

	
	

	

3.4 Pengaturan	Effect	Options	&	Timeline	
Motion	Path	adalah	efek	Keluar	atau	bahkan	Masuk		
suatu	kata	atau	gambar	pada	slide	tergantung	kita		
membuat	atau	menarik	garis.	Didalam	Motion	Path	ada		
efek	Diagonal	Down	Right,	Diagonal	Up	Right,	Down,	Left	,		
Right	,Up	,Draw	Custom	Path	(Line,Curve,Freeform	dan		
Scribble)		atau	efek	lain	ditandai	dengan	tulisan	more	effects.		
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3.5 Praktik	Pertemuan	ke	3	
Buatlah	presentasi	slide	berikut	:	

	

	

	

	KETENTUAN	:	
	

• Buatlah	Animasi	Entrance		
• Buatlah	Animasi	Emphasis	
• Buatlah	Animasi	Exit	
• Buatlah	Effect	Option	&	Timeline	
• Masukkan	gambar,	WordArt	dan	Tabel	
• Selamat	berkreasi	☺	
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4. Membuat	Grafik	SmartArt	
Grafik	SmartArt	adalah	representasi	visual	dari	informasi	dan	gagasan	Anda.	Buat	grafik	SmartArt	dengan	
memilih	salah	satu	opsi	tata	letak	untuk	menyampaikan	pesan	dengan	cepat,	mudah,	dan	efektif.	Grafik	
SmartArt,	 khususnya	 yang	 digabungkan	 dengan	 fitur	 lain	 seperti	 tema,	 membantu	 Anda	 membuat	
ilustrasi	berkualitas	desainer	hanya	dengan	beberapa	klik	mouse.		
	

4.1 Membuat	Grafik	Data	untuk	Presentasi	
1. Pada	tab	insert,	dalam	group	illustrations,	klik	SmartArt	

	

	

2. Dalam	kotak	dialog	pilih	grafik	SmartArt,		
klik	tipe	dan	tata	letak	yang	diinginkan.	

3. Masukkan	text	yang	anda	ingin	buat.	
	

4.2 Membuat	SmartArt	
1. Pada	tab	Design,	terdapat	Group	Create	Graphic,	Layouts,	Change	Color,	SmartArt	Styles	dan	Reset	
2. Anda	dapat	merubah	design	grafik	maupun	warna.		

	

	
	
	

PERTEMUAN KE 4      GRAFIK  SMARTART  SEDERHANA MICROSOFT POWERPOINT 2013  
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4.3 Praktik	Pertemuan	ke	4	
Buatlah	presentasi	slide	berikut	:	
	

	
	

	
	
	KETENTUAN	:	
	

• Buatlah	Grafik	Data	untuk	presentasi		
• Buatlah	SmartArt	
• Selamat	berkreasi	☺		
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5. Animation	Pane	
Animation	Pane	adalah	sebuah	jendela	atau	panel	yang	berfungsi	untuk	menampilkan	daftar	dari	animasi	
yang	ada	dalam	sebuah	slide	dari	PowerPoint,	daftar	ini	mengurutkan	animasi	dari	yang	pertama	muncul	
sampai	yang	terakhir.		
Langkah-langkah	masuk	Animation	Pane	:	
1. Klik	tab	menu	animations	
2. Pilih	Animation	Pane	
3. Maka,	secara	otomatis	akan	muncul	di	sebelah	kanan	layar	

	

	
	

5.1 Menambahkan	Audio	
Langkah-langkah	menambahkan	audio	:	
1. Klik	tab	menu	insert	>	Pilih	ikon	Audio	
2. Pilih	Audio	on	My	PC	
3. Masukkan	audio	yang	anda	inginkan	
4. Pilih	Insert	
	

	
	

5.2 Menambahkan	Video	
Langkah-langkah	menambahkan	audio	:	
1. Klik	tab	menu	insert	>	Pilih	ikon	Video	
2. Pilih	Video	on	My	PC	
3. Masukkan	video	yang	anda	inginkan	
4. Pilih	Insert	
	

	
	
	

PERTEMUAN KE 5      ANIMATION PANE MICROSOFT POWERPOINT  2013  
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5.3 Praktik	Pertemuan	ke	5	
Buatlah	presentasi	slide	berikut	:	
	

	
	

	

	

	KETENTUAN	:	
	

• Buatlah	slide	presentasi	
• Masukkan	Audio	&	Video	pada	slide		
• Selamat	berkreasi	☺	
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6. Membuat	Slide	Master	
Slide	 master	 dapat	 digunakan	 untuk	 mengontrol	 seluruh	 elemen	 dalam	 slide,	 seperti	 layout,	 latar,	
kombinasi	warna,	huruf,	animasi,	dll.	Segala	sesuatu	yang	dimasukkan	ke	dalam	slide	master	akan	tampil	
di	seluruh	slide	secara	otomatis.	 Ini	sangat	membantu	jika	ingin	menampilkan,	misalnya	logo	atau	nama	
perusahaan,	di	setiap	slide.	
	

6.1 Langkah-langkah	Masuk	ke	Jendela	Slide	Master	
1. Pada	tab	menu	View	>	Pilih	Slide	Master	

	

2. Maka	tampilan	akan	seperti	berikut:		

	

6.2 Membuat	Hyperlink		
1. Klik	shape	

	
	
	

PERTEMUAN KE 6      SLIDE MASTER M ICROSOFT POWERPOINT  2013  
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2. Klik	tab	Insert	>	Klik	Hyperlink	

	

3. Pada	jendela	yang	terbuka	pilih	Place	in	This	Document,	karena	slide	yang	dituju	berada	pada	file	yang	
sama.	Kalau	slide	yang	dituju	berbeda	file,	maka	klik	pilihan	yang	di	atasnya.		

	

4. Pilih	slide	yang	dituju.	Pada	contoh	ini	adalah	Slide	2.	Slide	preview	akan	tampil	di	kolom	kanan.	
5. Jika	sudah	benar,	klik	OK.	

	
6.3 Membuat	Action	

Selanjutnya,	 kita	 akan	 membuat	button	atau	 tombol	 untuk	 mengembalikan	 tampilan	 ke	 slide	 awal.	
Sebenarnya,	ini	pun	bisa	dilakukan	menggunakan	Hyperlink.	Tapi,	kita	akan	berlatih	menggunakan	Action	
Button.	Perbedaan	Hyperlink	dan	Action	Button	adalah	dari	keragaman	fungsinya.	Selain	untuk	hyperlink,	
Action	Button	juga	memiliki	fungsi	lain.	Silakan	dicek	PowerPoint	masing-masing	untuk	melihatnya.	

Caranya	:	

1. Klik	shape	yang	akan	digunakan	sebagai	tombol	
2. Klik	insert	>	Klik	Action	
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3. Pada	jendela	yang	terbuka,	pilih	Hiperlink	to	
4. Klik	tanda	panah	ke	bawah	

	

5. Pada	slide	tujuan,	dalam	latihan	ini	slide	awal	atau	FisrtSlide	
6. Klik	OK	
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6.4 Praktik	Pertemuan	ke	6	
Buatlah	presentasi	slide	berikut	:	
	

	

	

	KETENTUAN	:	
	

• Buatlah	slide	master	presentasi	
• Buatlah	Hyperlink	
• Selamat	berkreasi	☺	
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7. Membuat	Slide	Pembelajaran	Interaktif	
Aplikasi	Powerpoint	selama	ini	hanya	digunakan	untuk	membuat	suatu	media	presentasi	atau	bahan	ajar	
yang	bersifat	satu	(1)	arah	saja	(non	interaktif),	dimana	pengguna	hanya	berlaku	sebagai	pendengar	atau	
penonton	 saja	 tanpa	 terlibat	 aktif	 dalam	 proses	 pembelajaran	yang	 ada	 dalam	 media	 tersebut	 secara	
mandiri.	Sebenarnya	Powerpoint	dapat	digunakan	untuk	membuat	suatu	media	pembelajaran	interaktif.	
	

7.1 Membuat	Effect	Loading	
1. Pilih	menu	insert	>	klik	shapes	
2. Buat	bentuk	persegi	panjang	seperti	bentuk	loading	

	

3. Klik	pada	kotak	tersebut	dan	masuk	ke	menu	animation		>	wipe	
4. Pilih	Effect	Options	>	From	Left		
5. Masuk	ke	Timing	>	Atur	Duration	

	

6. Klik	menu	transition	>	Timing	>	After:	00:03.00	
7. Tekan	F5.	Selesai	
	
	

PERTEMUAN KE 7       SLIDE PEMBELAJARAN INTERAKTIF  MICROSOFT  POWERPOINT  2013  
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7.2 Membuat	Drop	Down	Menu		
1. Pilih	menu	insert	>	klik	shapes	

	

2. Copy	(	Ctrl	+	C	)	tombol	yang	anda	buat	kemudian	paste	(	Ctrl	+	V	)	di	slide	2	

	

3. Selanjutnya		memberikan	hyperlink	pada	menu	slide	1		
4. Klik	insert	>	Action		

	
	
5. Klik	mouse	over	>	hyperlink	>	slide	
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6. Silahkan	aktifkan	slide	2.	Insert	>	action	>	hyperlink	to	:	-	slide…		

	

	
7.3 Membuat	Timer	

1. Pada	insert	tab	>	text	grup	>	text	box	
2. Ketik	angka	1	pada	text	box	>	ubah	ukuran	font	(	150	)	

	

3. Pilih	Transitions	>	Timing	>	After	00:01.00	

	

4. Klik	slide	yang	dibuat.	Tekan	CTRL	+	C	dan	CTRL	+	V	untuk	menyalin	slide	
5. Pilih	View	>	slide	sorter	
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6. Tekan	F5	.	Selesai.	
	

7.4 Membuat	Trigger	
Fungsi	Trigger	adalah	Fungsi	untuk	memicu	suatu	animasi	bergerak	dengan	menggunakan	tombol	berupa	
objek	pada	powerpoint.	Semisal	kita	mempunya	dua	objek	A	dan	B,	jika	kita	klik	pada	objek	A	maka	objek	
B	akan	bergerak,	seperti	definisi	trigger	sendiri	yaitu	pemicu.	
	
Langkah-langkah	membuat	Trigger	
1. Buat	sebuah	pertayaan	beserta	jawabannya	
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2. Buatlah	respon	atas	hasil	jawabannya	apakah	benar	atau	salah	

	

3. Klik	kata	“Benar”	kemudian,		
4. Pilih	Animations	>	fly	in	>	animation	pane	

	

5. Masuk	ke	timing	
On	clik	 :	Agar	animasi	berjalan	setelah	tombol	diklik	
Trigger	 :	Untuk	memicu	animasi	 bergerak	 [	 karena	 saya	 ingin	menganimasikan	 respon	 jawaban	
benar,	maka	trigger	diarahkan	ke	opsi	jawaban	benar.	Dalam	hal	ini	adalah	opsi	“a.	kota	kalong”]	
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6. Lakukan	hal	yang	serupa	pada	opsi		

jawaban	salah.	
7. Klik	OK	

	

	

	

	

	

	

8. Tekan	F5	dan	pilih	jawaban	a.	maupun	b.	
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7.5 Praktik	Pertemuan	ke	7	
Buatlah	presentasi	slide	berikut	:	

	

	

	

	KETENTUAN	:	
	

• Buatlah	effect	loading	
• Buatlah	trigger	
• Selamat	berkreasi	☺	
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8. Membuat	Video	Kreatif	di	PowerPoint	
Membuat	video	bisa	dilakukan	dengan	berbagai	cara,	salah	satunya	menggunakan	presentasi	PowerPoint.	
Cara	 ini	 jadi	 pilihan	 oleh	 banyak	 kreator	 video	 di	 YouTube	 atau	 YouTuber	 karena	 praktis	 tidak	
membutuhkan	camcorder	mahal	tapi	soal	kualitas	konten,	cukup	ampuh	menarik	penonton.	
	

8.1 Membuat	Video	Iklan	
1. Tambahkan	Text	Box,	Picture,	Video	atau	Audio	melaui	tab	insert	

	

2. Tambahkan	Animation	>	Float	in	>	Effect	Options	>	Animation	Pane	

	

PERTEMUAN KE 8      VIDEO KREATIF  MICROSOFT  POWERPOINT 20 13  
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3. Klik	 kanan	Animation	Pane	>	Pada	 jendela	menu	Swivel	 anda	dapat	mengubah	atau	menambahkan	
Effect,	Timing,	Text	Animation	

	

4. Kreasikan	sesuai	dengan	selera	anda	
5. Tekan	F5.	Selesai.	

	
8.2 Convert	File	PPT	ke	Video/Move	

Ketika	Anda	membuat	rekaman	presentasi,	semua	elemen	presentasi	(narasi,	animasi,	gerakan	penunjuk,	
pengaturan	waktu,	dan	seterusnya)	disimpan	di	presentasi	itu	sendiri.	Pada	dasarnya,	presentasi	menjadi	
video	 yang	 dapat	 ditonton	 oleh	 audiens	 Anda	 di	 PowerPoint.	 Sehingga	 Anda	 memiliki	 dua	 opsi	 untuk	
mengubah	presentasi	menjadi	video	yang	siap	untuk	ditampilkan:	
• Simpan/ekspor	presentasi	Anda	ke	format	file	video	(.	mp4	atau.	wmv).	
• Simpan	 presentasi	 Anda	 sebagai	 file	 Peragaan	 PowerPoint	 (.ppsx).	 (Peragaan	 PowerPoint	 muncul	

layar	penuh	dalam	peragaan	slide,	segera	siap	untuk	menampilkan).	
	

A. Menyimpan	Sebagai	Video	
1. Pilih	File	>	save	as	>	Save	as	type	:	PowerPoint	Picture	Presentation	(*.pptx)	
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2. Pilih	File	>	Export	>	Create	a	Video,	klik	Export	menjadi	Video.		

	

3. Dalam	 kotak	 daftar	 menurun	 pertama	 di	 bawah	 judul	Buat	 Video,	 pilih	 kualitas	 video	 yang	
diinginkan,	 yang	 terkait	dengan	 resolusi	 video	yang	 telah	 selesai	dibuat.	 Semakin	 tinggi	 kualitas	
video,	semakin	besar	ukuran	file.	(Anda	dapat	mengujinya	untuk	menentukan	kualitas	yang	sesuai	
kebutuhan).	

Opsi	 Resolusi	 Untuk	ditampilkan	di	
Ultra	HD	(4k)	1	2	 3840	x	2160,	ukuran	file	terbesar	 Monitor	Besar	
Full	HD	(1080p)	 1920	x	1080,	ukuran	file	besar	 Layar	computer	&	HD	
HD	(720)	 1280	x	720,	ukuran	file	sedang	 Internet	&	DVD	
Standar	(480p)	 852	x	480,	ukuran	file	terkecil	 Perangkat	portabel	

	
	 	 1	Opsi	ultra	HD	(4k)	hanya	tersedia	jika	menggunakan	Windows	10	
	 	 2	di	PowerPoint	2016,	opsi	ultra	HD	(4k)	tidak	tersedia	di	edisi	lisensi	volume	
	

4. Kotak	 menurun	 kedua	 di	 bawah	 Create	 a	 Video	 memberi	 tahu	 apakah	 presentasi	 anda	
menyertakan	 narasi	 dan	 pengaturan	 waktu.	 (Anda	 dapat	 mengganti	 pengaturan	 ini	 jika	
menginginkannya).	
• Jika	 Anda	 belum	 merekam	 narasi	 berjangka	 waktu,	 secara	 default	 nilainya	 adalah	Jangan	

Gunakan	Pengaturan	Waktu	dan	Narasi	yang	Direkam.	
• Waktu	default	yang	diperlukan	setiap	slide	adalah	5	detik.	Anda	dapat	mengubah	pengaturan	

waktu	 dalam	 kotak	Detik	 diperlukan	 di	 setiap	 slide.	 Di	 sebelah	 kanan	 kotak,	 klik	 panah	 atas	
untuk	menambah	durasi,	atau	klik	panah	bawah	untuk	mengurangi	durasi.	

• Jika	 Anda	 sudah	 merekam	 narasi	 berjangka	 waktu,	 secara	 default	 nilainya	 adalah	Gunakan	
Pengaturan	Waktu	dan	Narasi	yang	Direkam.	
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5. Klik	Create	Video	
6. Dalam	kotak	Nama	file,	masukkan	nama	file	untuk	video	tersebut,	cari	 folder	yang	akan	diisi	 file	

ini,	lalu	klik	Simpan.	
7. Dalam	kotak	Simpan	sebagai	tipe,	pilih	Video	MPEG-4	atau	Windows	Media	Video.	

Anda	dapat	melacak	perkembangan	pembuatan	video	dengan	melihat	bilah	status	di	sisi	bawah	
	layar	Anda.	Proses	pembuatan	video	dapat	makan	waktu	sampai	beberapa	jam,	tergantung	pada	
durasi	video	dan	kerumitan	presentasi.	

Tips:			Untuk	 video	 berdurasi	 panjang,	 Anda	 dapat	menyiapkannya	 untuk	 dibuat	 di	malam	hari.	
Dengan	cara	ini,	video	akan	siap	untuk	Anda	di	pagi	hari	berikutnya.	

8. Untuk	memutar	video	yang	baru	Anda	buat,	buka	lokasi	folder	yang	menampungnya,	lalu	double	
klik	pada	file.	
	

8.3 Praktik	Pertemuan	ke	8	
Buatlah	video	iklan	berdurasikan	1	Menit,	kemudian	convert	dalam	bentuk	Video.	
	

	

	


